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IMPORTANT SAFETY INSTRUCTIONS 
 

 

The lightning flash with arrowhead symbol within an equilateral triangle is 
intended to alert the user to the presence of uninsulated “Dangerous voltage” 
within the product’s enclosure that may be of sufficient magnitude to constitute 
a risk of electric shock to persons. 

 

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (Servicing) instructions 
in the literature accompanying the product. 

 
• Read these instructions 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water 
• Clean only with dry cloth. 
• Do not block any ventilation openings.  Install in accordance with the manufacturer’s instructions. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus 

(including amplifiers) that produce heat. 
• Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has two 

blades with one wider than other.  A grounding-type plug has two blades and a third grounding prong.  
The wide blade or the third prong is provided for your safety.  If the provided plug does not fit into your 
outlet, consult an electrician for replacement of the obsolete outlet. 

• Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the apparatus. 

• Only use attachments/accessories specified by the manufacturer 
• Unplug this apparatus during lightning storms or when unused for long periods of time. 
• Refer all servicing to qualified service personnel.  Servicing is required when the apparatus has been 

damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or 
objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not 
operate normally, or has been dropped. 

 

WARNING 
TO REDUCE THE RISK OF FIRE OR ELECTRIC – SHOCK, DO NOT EXPOSE THIS APPARATUS 
TO RAIN OR MOISTURE 

WARNING 
DO NOT EXPOSE THIS EQUIPMENT TO DRIPPING OR SPLASHING AND ENSURE THAT NO 
OBJECTS FILLED WITH LIQUIDS ARE PLACED ON THE EQUIPMENT 

WARNING  
TO COMPLETELY DISCONNECT THIS EQUIPMENT FROM THE AC MAINS, DISCONNECT THE 
POWER SUPPLY CORD PLUG FROM THE AC RECEPTACLE 

WARNING  
THE MAINS PLUG OF THE POWER SUPPLY CORD SHALL REMAIN READILY OPERABLE 

  



 
 

 

INFORMATION TO USERS IN EUROPE 
 

NOTE 
 

CISPR 22 CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to the European Union EMC directive.  These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment.  This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.  
Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense. 
 

 
 

INFORMATION TO USERS IN THE U.S.A. 
 

NOTE 
 

FCC CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment.  This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications.  Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

 
WARNING 

 
Changes or Modifications not expressly approved by Evertz Microsystems Ltd. could void the user’s 
authority to operate the equipment. 
 
Use of unshielded plugs or cables may cause radiation interference.  Properly shielded interface cables 
with the shield connected to the chassis ground of the device must be used. 

 
 

 
 
 

 

EN60065 Safety  

 

EN504192 2005 
Waste electrical products should not be 

disposed of with household waste. 
Contact your Local Authority for recycling 

advice 

EN55103-1: 1996 Emission 
EN55103-2: 1996 Immunity 
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor for 
the rights of third parties, which may be affected in any way by the use thereof.  Any representations in this document concerning performance of 
Evertz products are for informational use only and are not warranties of future performance, either expressed or implied. The only warranty offered 
by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no warranty is 
granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or order confirmation.  
Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If you encounter an error, 
please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make changes in equipment design or 
specifications. 
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1. OVERVIEW 
The 7800DA2T Dual 3G/HD/SD-SDI Reclocking Distribution Amplifier provides high quality distribution of 
facility 3G/HD/SD-SDI signals. HD versions support SMPTE ST 292-1 and SMPTE ST 259 signals while 
3G versions also support SMPTE 424M signals. This module features dual auto-sensing equalized inputs 
with unparalleled cable equalization, making it the most-cost effective and ideal solution for long cable run 
environments. 
 
The included dual bypass relays offer failure proof protection for critical paths. 
 
For maximum flexibility, the module can operate in a dual input to three outputs each configuration or as 
one input to six output configuration. 
 
The 7800DA2T is VistaLINK® enabled, offering remote monitoring, control and configuration capabilities 
via Simple Network Management Protocol (SNMP) giving the flexibility to manage operations, including 
signal monitoring and module configuration from SNMP capable control systems (Manager or NMS). 
 
The 7800DA2T occupies one card slot and can be housed in the 3RU 7700FR-C, 7800FR and 7800FR-
QT frames that have a 15-slot capacity. The 7700FC frame controller is required for configuration. 
 
Features: 
• HD/SD-SDI dual input with three reclocked outputs per input 
• Bypass relay protection included for both inputs 
• Support for common 3G-SDI video inputs (-3G versions)  
• Configurable as one DA with six outputs or two DAs with three outputs each (1x6 or 2 - 1x3) 
• Industry leading long reach cable performance 
• Input signal presence detection 
• High density approach offers 14 modules within 3RU (28 DA’s in 3RU) 
• Real time VistaLINK® monitoring and trending for SNMP monitoring 

 
 

 

NOTE:  From this point forward, the 7800DA2T-3G and the 7800DA2T-HD modules will be 
referred to as the 7800DA2T, unless the feature in question is applicable only to one of the 
modules, in which case the specific model number will be referenced. 
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Figure  1-1 : 7800DA2T-3G Block Diagram 
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2. INSTALLATION 
The 7800DA2T comes with a companion rear plate that occupies one slot in the frame. For information 
on inserting the module into the frame see section 3 of the 7800FR chapter. 

 

 
Figure  2-1 : 7800DA2T-3G/7800DA2T-HD Rear Panels 

 
 
3G/HD/SD-SDI INPUT: There are two input DIN 1.0/2.3 connectors for 10-bit serial digital video 

signals compatible with the 3Gb/s SMPTE 424M, 1.5Gb/sec SMPTE 292M, 
and 270Mb/s SMPTE 259M-C (525i/59.94 or 625i/50) standard.   

 
3G/HD/SD-SDI OUTPUT: There are six DIN 1.0/2.3 connectors with reclocked serial digital video 

outputs, compatible with the 3Gb/s SMPTE 424M, 1.5Gb/sec SMPTE 292M, 
and 270Mb/s SMPTE 259M-C (525i/59.94 or 625i/50) standard.  
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3. SPECIFICATIONS 
3.1. SERIAL VIDEO INPUT 

Standard:   Auto-detects standard 3Gb/s SMPTE 424M, 1.5Gb/sec SMPTE 292M, 270Mb/s 
SMPTE 259M-C (525i/59.94 or 625i/50) 

 
Connector:   1 DIN 1.0/2.3 connector (1x6 mode) 

2 DIN 1.0/2.3 connectors (2 by 1x3 mode) 
 

Input Equalization:  Automatic to  
150m @ 3Gb/s (Belden 1694A cable) 
200m @ 1.5Gb/s (Belden 1694A cable) 
380m @ 270Mb/s (Belden 1694A cable) 
 

Return Loss:              > 10dB up to 3Gb/s 
> 15dB up to 1.5Gb/s 
> 20dB up to 270 Mb/s 
 

3.2. SERIAL VIDEO OUTPUTS 

Standard:  Auto-detects standard 3Gb/s SMPTE 424M, 1.5Gb/sec SMPTE 292M, 270Mb/s 
SMPTE 259M-C (525i/59.94 or 625i/50) 

 
Number of Outputs: 3 per path (2 by 1x3 mode) 
  6 (1x6 mode) 
 
Connector:   DIN 1.0/2.3 connector 
 
Signal Level:  800mV nominal 
 
DC Offset:  0V ±0.5V 
 
Rise and Fall Time: 200ps nominal for 3G/HD-SDI 
  900ps nominal for SD-SDI 
 
Overshoot:   < 10% of amplitude 
 
Return Loss:             > 10dB for 1.5 - 3Gb/s 

> 20dB up to 1.5Gb/s 
 

Alignment Jitter: < 0.3 UI for SMPTE 424M 
  < 0.20 UI for SMPTE 259M and 292M 
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3.3. ELECTRICAL 

Voltage:  + 12VDC 
 
Power:  6 Watts 
 
EMI/RFI:  Complies with FCC regulations for class A devices 

Complies with EU EMC directive 

3.4. PHYSICAL 

Number of slots: 
 

350FR:  1 
7700-FR-C: 1 

7800FR:  1 

7800FR-QT: 1 
7801FR:  1 
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4. STATUS LEDS 
The 7800DA2T has eight LED status indicators on the front card edge to show operational status of the 
card at a glance. Figure  4-1 shows the location of the LEDs. 
 
Two large Module Status LEDs on the front of the board indicate the general health of the module: 
 
LOCAL FAULT: This Red LED indicates poor module health and will be On during the absence of a 

valid input signal (on either of the two inputs if in dual 1x4 mode) or if a local input 
power fault exists (i.e.: a blown fuse). The LOCAL FAULT indication can also be 
reported to the frame through the FRAME STATUS jumper.  

 
MODULE OK: This Green LED indicates good module health. It will be On when a valid input 

signal is present (on both inputs if in dual 1x4 mode), and board power is good. 
 
There are 18 small LEDs that are not currently implemented. Figure  4-1 identifies the function of some of 
the status LEDs present on the board. 
 
 

7800IDA2Q-3G

Shaft 
Encoder

Module 
Status

4 Character
Dot Matrix

Display

 
Figure  4-1 : Status LEDs 
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5. CARD EDGE MODULE CONTROL 
5.1. CARD-EDGE CONTROL 

The 7800DA2T is equipped with a push-button shaft encoder and a four character dot matrix display to 
control various functions on the card. The push-button shaft encoder is used to navigate through a menu 
system to set and monitor various parameters for the module. When not in the menu system the four 
character dot matrix display rotates through the module name, firmware version and IP address. 

5.1.1. Navigating the Card-Edge 
You can use the push-button shaft encoder to move up and down the list of available parameters to 
adjust. To adjust any parameter, use the shaft encoder to move up or down to the desired parameter and 
then press the shaft encoder in. If the parameter is a numerical value, the number will increase if you 
rotate the shaft encoder clockwise and decrease if you rotate the shaft encoder counter-clockwise. If the 
parameter contains a list of options, you can cycle through the list by rotating the shaft encoder in either 
direction. The parameter values are changed as you cycle through the list. 
 
When you have stopped at the desired value, depress the shaft encoder. This will return you to the 
parameter, select the menu item that you are setting (the display shows the parameter name you were 
setting). To change another parameter, rotate the shaft encoder to select other parameters.  If neither the 
toggle switch nor pushbutton is operated for several seconds the card edge control will exit the menu 
system and return to an idle state. 
 
Throughout the descriptions of the Menu items, default values are shown with bolded text. 
 

5.2. CARD-EDGE MENU STRUCTURE 

The following is a brief description of the top level of the menu tree that appears when you enter the ON 
screen menu. Selecting one of these items will take you down into the next menu level to set the value of 
that parameter. 
 
DSPL  Sets the orientation of the four-digit LED display 
PRST  Allows the saving or recalling of presets 
QUIT  Exits the menu 

 

5.3. SETTING THE DISPLAY ORIENTATION 

The DSPL parameter controls the display orientation of the four digit LED display. 
 

HORZ The display will be shown horizontally (ideal when installed in a 1RU or 
standalone frame). 

VERT The display will be shown vertically (ideal when installed in a 3RU frame).  
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5.4. PRESET PARAMETERS 

The PRST menu option enters into a selection menu to either recall or save a preset. 
 
SAVE Menu option to save current module state to a selected preset. 

LOAD Menu option to load to the module a selected preset. 
 

5.4.1. Saving Presets 
The SAVE parameter will save the current module settings to a selected preset number. The user can 
save the settings by assigning a preset number (i.e. Preset 02), which can later be recalled using the load 
parameter. 
 
01-10 Selects the preset to save the current module settings to. 

 

5.4.2. Loading Presets 
The LOAD parameter will load the settings saved in the preset to the current module settings. The user 
can recall and load a saved preset by selecting the desired preset number (i.e. Preset 02).   
 
FACT Loads the factory default settings into the module. 

01-10 Selects the preset from which to load settings from. 
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6. VISTALINK® MODULE CONTROL 

This section describes the VistaLINK® control and monitoring available on the 7800DA2T.  
 
6.1. WHAT IS VISTALINK®? 

VistaLINK® is Evertz’s remote monitoring and configuration platform which operates over an Ethernet 
network using Simple Network Management Protocol (SNMP). SNMP is a standard computer network 
protocol that enables different devices sharing the same network to communicate with each other. 
VistaLINK® provides centralized alarm management, which monitors, reports, and logs all incoming alarm 
events and dispatches alerts to all the VLPro Clients connected to the server. Card configuration through 
VistaLINK® PRO can be performed on an individual or multi-card basis using simple copy and paste 
routines, which reduces the time to configure each module separately. Finally, VistaLINK® enables the 
user to configure devices in the network from a central station and receive feedback that the configuration 
has been carried out. 
 
There are 3 components of SNMP: 
 
1. An SNMP manager also known as a Network Management System (NMS) is a computer running 

special software that communicates with the devices in the network. Evertz VistaLINK® Pro Manager 
graphical user interface (GUI), third party or custom manager software may be used to monitor and 
control Evertz VistaLINK® enabled products. 
 

2. Managed devices, each with a unique address (OID), communicate with the NMS through an SNMP 
Agent. Evertz VistaLINK® enabled 7700/7800 series modules reside in the 3RU 7800FR MultiFrame 
and communicate with the manager via the 7700FC VistaLINK® frame controller module, which serves 
as the Agent. 
 

3. A virtual database known as the Management Information Base (MIB) lists all the variables being 
monitored, which both the Manager and Agent understand. Please contact Evertz for further 
information about obtaining a copy of the MIB for interfacing to a third party Manager/NMS. 

 
For more information on connecting and configuring the VistaLINK® network, see the 7700FC Frame 
Controller chapter. 
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6.2. GENERAL 

The General section shows miscellaneous parameters of the module.  
 

 
Figure  6-1 : VistaLINK® PRO - General Section 

 

6.2.1. Information 
Card Name: Indicates the product model number of the card (including installed options). 

Firmware Creation Date: Indicates the build date of the firmware version. 
Firmware Version: Indicates the currently installed firmware version. 
Board Name: Indicates the product hardware version of the module. 
Board Revision: Indicates the hardware version of the module. 

Board Serial Number: Indicates the physical serial number of the module. 
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6.3. VIDEO CONTROL 

The Video Control section is used to select between the modes of operation. 
 

 
Figure  6-2 : VistaLINK® PRO - Video Control Section 

 
Video Mode: The Video Mode drop down menu allows the user to set the mode of the card. 
 
2x3 Sets the card in dual 1x3 mode. 

1x6 Sets the card in 1x6 mode.  
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6.4. PRESETS CONTROL 

The Presets Control section allows the saving and recalling of presets.  
 

 
Figure  6-3 : VistaLINK® PRO - Presets Control Section 

 

6.4.1.  Presets 
Save: The Save drop down menu will save the current module settings to a selected preset number. The 
user can save the settings by assigning a preset number (i.e. Preset 02), which can later be recalled 
using the load parameter. Possible options are as follow: 
 
Preset 1-10 Selects the preset to save the current module settings to. 

Cancel Cancels the selection.  
 
Presets Load: This drop down menu will load the settings saved in the preset to the current module 
settings. The user can recall and load a saved preset by selecting the desired preset number (i.e. Preset 
02). Possible options are as follow: 
 
Factory Defaults Loads the factory default settings into the module. 

Preset 1-10 Selects the preset from which to load settings from. 

Cancel Cancels the selection. 
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6.5. MONITOR 

The Monitor section shows video parameters of the module. 
 

 
Figure  6-4 : VistaLINK® PRO - Monitor Section 

 

6.5.1. Video Status 
 
Video Standard – Input 1:  This field displays the currently detected input video standard of input 1.  

Video Standard – Input 2: This field displays the currently detected input video standard of input 2 when 
the card is in 2 - 1x3 mode.  
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6.6. INPUT 1 FAULT TRAPS 

The Input 1 Fault Traps section shows the trap status for input 1 of the module.  
 

 
Figure  6-5 : VistaLINK® PRO - Input 1 Fault Traps Section 

 
To enable a particular trap, simply click the box located beside each trap in the Trap Enable section so 
that a check mark appears. When a check mark is present, the trap is enabled. When a check mark is not 
present, the trap is disabled.   
 
If a parameter under the Trap Status section is green, then the trap is present. If the parameter is red, 
then the trap is missing.  
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6.7. INPUT 2 FAULT TRAPS 

The Input 2 Fault Traps section shows the trap status for input 2 of the module.  
 

 
Figure  6-6 : VistaLINK® PRO - Input 2 Fault Traps Section 

 
To enable a particular trap, simply click the box located beside each trap in the Trap Enable section so 
that a check mark appears. When a check mark is present, the trap is enabled. When a check mark is not 
present, the trap is disabled.   
 
If a parameter under the Trap Status section is green, then the trap is present. If the parameter is red, 
then the trap is missing.  
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7. JUMPERS AND USER ADJUSTMENTS 

MODULE STATUS
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Figure  7-1 : LED and Jumper Locations  

 

7.1. SELECTING WHETHER LOCAL FAULTS WILL BE MONITORED BY THE GLOBAL FRAME 
STATUS 

The FRAME STATUS jumper J3, located at the front of the module determines whether local faults (as 
shown by the Local Fault indicator) will be connected to the 7700/7800 series frame's global status bus. 
 
FRAME STATUS: To monitor faults on this module with the frame status indicators (on the power 

supply’s FRAME STATUS LED's and on the Frame's Fault Tally output) install this 
jumper in the “On” position. 

 
 When this jumper is installed in the “Off” position local faults on this module will not 

be monitored. 
 
7.2. CONFIGURING THE MODULE FOR FIRMWARE UPGRADES 

UPGRADE: The UPGRADE jumper J5 located at the front of the module near the card ejector is used 
when firmware upgrades are being done to the module.  For normal operation it 
should be installed in the RUN position. See the Upgrading Firmware section in the 
front of the binder for more information. 

 
 To upgrade the firmware in the module unit pull it out of the frame. Move Jumper 

J16 into the UPGRADE position. Install the Upgrade cable provided (located in the 
vinyl pouch in the front of this manual) onto header J6. Re-install the module into the 
frame. Run the upgrade as described in the Upgrading Firmware section in the front 
of the binder. Once the upgrade is complete, remove the module from the frame, 
move J5 to the RUN position, remove the upgrade cable and re-install the module. 
The module is now ready for normal operation. 
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8. UPGRADE PROCEDURES 

8.1. UPGRADE FIRMWARE 

A firmware upgrade can be accomplished through VistaLINK® PRO firmware upgrade facilities. All 
7800DA2T modules within the same 7700FR/7800FR frame can be upgraded simultaneously or  
one-by-one.  However, it is more convenient to upgrade them simultaneously. 
 
Right click on 7700FR/7800FR frame that contains the 7800DA2T modules, and select Version 
Information. 

 
Figure  8-1 : VistaLINK® PRO - Version information selection 

 
 
Navigate the hardware tree on the left side of the version information window to select the  
7800DA2T module listed. The list on the right side of the window should populate with all 7800DA2T 
modules present in the 7700FR/7800FR.Take note of the current firmware version installed on the 
7800DA2T modules to confirm afterwards that the upgrade has completed successfully. 
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Figure  8-2 : VistaLINK® PRO - Version Information Window 

 
Check the Upgrade checkbox for all modules that require the firmware upgrade. Press Upgrade button.  
This will open a new Upgrade Firmware window. Press the Browse button to navigate to the firmware 
archive provided for upgrading the 7800DA2T modules (File extension is .bin). Once the correct file has 
been selected, press the Start button to begin the upgrade process. 
 

 
Figure  8-3 : VistaLINK® PRO - Upgrade Firmware Window 

After the firmware has been transmitted to the 7800DA2T module successfully, the module will reboot to 
complete the firmware upgrade process. Close the Upgrade Firmware window and  
Version Information window. 
Once the cards have rebooted, ensure all 7800DA2T modules are still present in the VistaLINK® PRO 
hardware tree. Right click on 7700FR/7800FR frame that contains the 7800DA2T modules and select 
Version Information. Navigate the hardware tree on the left side of the version information window to 
select the 7800DA2T module listed. The list on the right side of the window should populate with all 
7800DA2T modules present in the 7700FR/7800FR. 
 

 
NOTE: If any of the 7800DA2T modules do not properly upgrade the firmware, please 
power-cycle those boards and retry the procedure exclusively on the failed boards.  If the 
issue still persists, contact Evertz for further assistance. 

updating vlpro server jar file 
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Products from Evertz are constantly evolving and new features are often added. It is therefore important to 
update the JAR files in use to provide access to all the latest features or enhancement. It will also be 
necessary to add JAR files for new products. 
 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed will 
automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro Server 
window from the Windows task bar, select Help>Apply Update>Product from the menu. 
 

 
Figure  8-4 : VistaLINK® PRO Server/Apply Update 

A window will appear, as shown in Figure  8-5. Navigate to the location of the new JAR file and double click 
to select the file. The window will automatically close and the update will be applied in the background. 
 

 
Figure  8-5 : VistaLINK® PRO – Applying JAR Updates 

You will be prompted to restart the server to enable the change to take effect. Apply as many JAR updates 
as required before restarting the server. 
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 
NOTE: You may confirm that all updates have been successfully applied by selecting from 
the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the start up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts, a short delay may happen while the 
update is applied. A prompt will appear confirming that the updates have been applied. 
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